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Safety and Handling Instructions

Caring For 
Your Player 

While your player is quite robust, observing these handling procedures will 
prolong its life.

Do not store or 
use in areas 
exceeding 45ºC 
or 113ºF.

Do not subject to 
excessive force or 
impact.

Do not expose to 
heat or incinerate.

Keep away from 
excessive 
moisture.

Keep away from 
strong magnetic 
fields.

Do not dismantle.
Safety and Handling Instructions xiii



Battery Usage 
Precautions 

When charging or handling your player’s battery, take note of these 
precautions:

Never modify or 
disassemble the 
battery. If there is 
leakage, stench, 
discoloration or 
deformation during 
charging or use, 
remove the battery and 
do not use it again. 
Clean your hands well 
before  handling food 
or touching sensitive 
areas of your body, for 
example, your eyes.

 

Do not expose to 
heat or fire.

Avoid contact with 
metal objects like 
keys or 
necklaces.

Do not pierce or 
crush.

Store away from 
direct sunlight.

Avoid contact with 
moisture.

Do not store or 
use in areas 
exceeding 45ºC 
or 113ºF.
Safety and Handling Instructions xiv



Introduction



Introduction 

Congratulations on making an excellent decision in purchasing the Creative 
NOMAD Jukebox Zen NX! 

Your new multi-format portable player is extremely lightweight, just about 8.0 
ounces (226 grams). Even though it is no bigger than a normal portable 
cassette player, you can store thousands of songs in the player’s music 
library.  Your player also comes equipped with an USB 2.0™ connector, so 
you can transfer audio tracks and data quickly and easily. 

Unlike other hardware-based players, the NOMAD Jukebox Zen NX features 
an onboard real-time digital signal processor (DSP) and a real-time effects 
processor for superior audio playback and customization. Your player also 
supports EAX™ so that you can enhance your audio with Advanced EQ 
presets, headphone spatialization, environments and effects. Your portable 
digital audio player supports multiple audio file formats, including MP3, WMA 
and WAV.

The product name may 
vary from country to 
country.
Introduction xvi
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Before You Begin

Package 
Contents

Hardware ❍ NOMAD Jukebox Zen NX Player (with removable battery)
❍ AC Power Adapter
❍ Installation CD incorporating PDF User’s Guide
❍ Quick Start leaflet
❍ Stereo headphones
❍ USB cable
❍ Protective pouch
❍ Lithium-ion rechargeable battery

Software ❍ Creative MediaSource Player
❍ Creative MediaSource Organizer
❍ Creative File Manager 2
❍ Adobe Acrobat Reader
Before You Begin xviii



Creative 
MediaSource 
Player

Creative MediaSource Player is the only software you will need for music 
and multimedia entertainment. Unlike other media players, Creative 
MediaSource Player is specially designed to access the power of NOMAD 
Jukebox Zen NX’s hardware. With it, you can:
❍ play back music and multimedia files: MP3, WAV, WMA, WMV, NVF, 

VideoCD, etc*
❍ enhance playback of ordinary music with surround effects using EAX
❍ vary the speed of audio playback without affecting the pitch (Time 

Scaling)*
❍ use Smart Volume Management to play back a list of songs at a similar 

volume level even if they were originally recorded at different loudness 
levels*

❍ switch between Creative MediaSource Organizer and Creative 
MediaSource Player with just a click of the mouse

Creative 
MediaSource 
Organizer

Managing a huge collection of audio CDs and MP3 files can be a headache. 
With Creative MediaSource Organizer, you can find any track easily, no 
matter where it is stored on your hard disk or external storage devices.

* To enjoy this feature, you must have a Creative Sound Blaster Audigy 2 audio card installed
in your system.
Before You Begin xix



Creative File 
Manager 2

 Creative File Manager 2 helps you manage your player’s audio tracks and 
data files within Windows® Explorer. 

With Creative File Manager 2, you can conveniently organize and transfer 
files between your computer and your NOMAD Jukebox, or between different 
NOMAD Jukeboxes, using familiar Windows methods, such as Drag-and-
Drop and Cut-and-Paste.

As Creative File Manager 2 has been integrated with Microsoft Windows 
Explorer, you can easily copy or move data files to and from your player, just 
like a portable storage device.

Creative File Manager 2 also lets you copy audio tracks to  your player's 
Music Library. However, you will not be able to view your player's Music 
Library with Creative File Manager 2. For more audio track management 
options for your player, it is recommend that you use Creative MediaSource 
instead.

Adobe Acrobat 
Reader

Adobe Acrobat Reader is a software that lets you view and print Adobe 
Portable Document Format (PDF) files on all major computer platforms. 
Before You Begin xx



Minimum 
System 
Requirements 

❍ Microsoft® Windows® 98 Second Edition (SE), Windows 2000, Windows 
Millennium Edition (Me) or Windows XP

❍ Intel® Pentium® II 233 MHz, AMD®-K6-2® 266 MHz or better processor 
(Pentium III 450 MHz or higher recommended for MP3 encoding)

❍ Sound Blaster Live!™, Sound Blaster Audigy™ or Sound Blaster 
Extigy™ for EAX enhanced MP3 encoding

❍ CD-ROM drive with digital audio extraction support
❍ USB 1.1 or 2.0 port
❍ 64 MB RAM (128 Megabytes recommended)
❍ 30 MB free hard disk space (more needed for storing audio)
❍ Internet connection for Internet content downloading and CDDB2™ 

support (any charges incurred are the responsibility of the user)
❍ Installed mouse
❍ SVGA graphics adapter (256 colors, 800 x 600 resolution or better)

The software 
applications on the 
installation CD may 
have higher 
requirements for 
basic functionality. 
Refer to each 
application’s 
documentation for 
details
Before You Begin xxi



Document 
Conventions

We use icons to highlight useful or urgent information for you:

 

Tip. This tells you about shortcuts or hints relating to a feature.

Note. This highlights additional or important information about 
a feature.

Caution! This highlights proper usage of your player. Use this 
information to avoid situations involving risk.

Warning! This warns you of possible hazards to yourself or 
your player, which may result in injury or damage.
Before You Begin xxii



Web 
Information 

Visit www.NOMADworld.com regularly for information on:
❍ firmware updates
❍ NOMAD accessories 
❍ tips and tricks
❍ FAQs
❍ troubleshooting
❍ documentation updates
❍ software updates or purchases
❍ technologies used in your player
❍ an online glossary
Before You Begin xxiii



Optional Player 
Accessories

Visit www.NOMADworld.com to learn more about these accessories.

❍ The Car Kit comes with a Cassette 
Adapter that connects your player to a 
car cassette player.

❍ You can get an additional removable 
Lithium-Ion battery for your battery.

Car Kit

Removable battery
Before You Begin xxiv



Online 
Registration

Enjoy a host of benefits by registering your products during installation, or at 
www.creative.com/register. 

Benefits include: 
❍ Service and Product support from Creative.
❍ Exclusive updates on promotions and events!

To register online, 
your player must 
be connected to the 
computer.
Before You Begin xxv
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A Tour of Your Player

Your Player at 
a Glance

USB connector
connects a USB cable 
from your player to 
your computer to 
transfer data or audio 

Headphones connector
connects to your 
headphones.

Menu button 

Play/Pause 
button

Forward/Reverse 
button

Scroller 

LCD screen 

Back 
button 

Power adapter 
connector

Power 
button 

Reset 
button 

Volume 
button 

Open switch
To change or insert the 
battery, push the switch 
to the right to open your 
player’s cover.
A Tour of Your Player 1-1



Using the 
Scroller

Scroll Select The Scroller is one of the most important features of your NOMAD Jukebox 
Zen NX. In this document, we will use a new term, “Scroll Select”, to indicate 
that you should use the Scroller to scroll through options and then select the 
option by pressing the Scroller.

Depending on the screen you are in, you can have different menu options. 
You can also choose options from a list or a confirmation box.

To "Scroll Select", 
use the Scroller to 
scroll to the option 
you want, and select 
the option by 
pressing the Scroller.

Use the Scroller to scroll 
through options

Press the Scroller to select an 
option

The Scroller 
(side view)
A Tour of Your Player 1-2



Selecting menu 
options

You can use the Scroller to make selections in menus. For example, if you 
are looking at the Menu screen:

1. Use the Scroller to scroll up and down in the menu.
2. Press the Scroller to select the menu item.

Selecting list and 
confirmation box 
options

You can also use the Scroller to select confirmation boxes or options in a list.

1. Move the Scroller to scroll through the options. 
2. Press the Scroller to select the option.

From the Menu screen to the Settings screen

Scroller options

Unlocking the playerConstructing a title from a list
A Tour of Your Player 1-3



Button What It Does Usage Tips

POWER

❍ turns the player on and off
❍ disables all buttons except for the scroller

❍ press and hold until player turns 
on or off

❍ when the player is turned on, 
press this button. The Lock 
player? window appears. Use 
the scroller and select the check 
mark icon.

MENU

❍ accesses most of your player’s features
❍ activates LCD backlight

FORWARD/
REVERSE

❍ skips to the next track
❍ skips forward to portions of a track when 

you press and hold the button
❍ skips to the beginning of the current track, 

or to the previous track
❍ skips to previous portions of a track when 

you press and hold the button

❍ to skip forward or go back to 
another track, press the Menu 
button, and then Scroll Select 
Selected Music to get to the 
Selected Music screen. Use the 
scroller and select the track you 
want to skip to.

PLAY/PAUSE

❍ starts, pauses, stops or continues 
playback

❍ to play a track from the Music 
Library screens, press and hold 
this button
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VOLUME  

❍ increases the volume 

❍ decreases the volume

❍ press and hold the end of 
the button to increase the 
volume quickly

❍ press and hold the end of 
the button to decrease the 
volume quickly

SCROLLER 

❍ scrolls up and down menus
❍ selects menu options

❍ turn the Scroller to scroll through 
menu options and press the 
Scroller to select them. This 
action is also referred to as 
"Scroll Select".
To Scroll tracks continuously, 
hold the Scroller until you reach 
the track that you want.

BACK 

❍ goes to previously accessed screens

RESET  
❍ resets your player if it stops reponding

❍ insert the end of a thin object, 
like a paper clip, into the button

OPEN SWITCH ❍ To change or insert the battery, push the 
switch to the right to open your player’s 
cover.

Button What It Does Usage Tips
A Tour of Your Player 1-5
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Getting Started

Inserting the 
battery

1. Push the Open switch to the right as shown in Figure 2-1. The cover 
pops open.

2. Insert the battery into your player.
3. Position the hooks of cover over the openings as shown in Figure 2-2.

Open switch

Figure 2-1: Opening the cover.

Hook

Opening

Figure 2-2: Positioning hooks of cover.
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4. Press the cover gently to snap shut as shown in Figure 2-3.

Figure 2-3: Securing the cover.
Getting Started 2-2



Charging the 
Battery

The high performance lithium-ion battery supplied with your player needs to 
be fully charged before you use it. Your player’s built-in battery charger will 
fully charge the battery (in approximately 4 hours) to obtain the maximum 
playback time. To charge your player’s battery:
1. Connect your player to the wall outlet (Figure 2-4).

Your player will turn itself on.
2. Check the battery icon to see when the battery is fully charged.

AC adapter 
connector

Power socket

Figure 2-4: Connecting the player to a power socket.
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Power Source 
and Level 
Indicators

Your player displays one of the following icons, depending on the battery’s 
charged status or the power source (battery or electrical power).

Icon What the icon means Notes

❍ your player is running from electrical 
power only

❍ your player is running from battery power 
only

❍ this battery state icon shows that 
the battery is fully charged

❍ your player’s battery is 60% full

❍ your player’s battery is 30% full
❍ recharge the battery at the earliest 

opportunity

❍ your player is running from electrical 
power and is charging the battery

❍ charge the battery fully before 
disconnecting the player from the 
power outlet

❍ while charging, the icon will 
alternate between this icon and a 
battery state icon, showing the 
approximate level of charge

❍ your player is running from electrical 
power and has finished charging the 
battery

❍ to use battery power, disconnect 
the player from the power outlet
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Installing 
Software

Your NOMAD Jukebox Zen NX comes with software that helps you create 
audio tracks, manage your music library and use your player. 

1. Make sure that your player is not connected to your computer.
2. Insert the Installation CD into your CD-ROM drive.
3. The Installation CD supports Windows AutoPlay mode and starts 

running automatically. If not, you need to enable your CD-ROM drive's 
auto-insert notification feature. For more details see "AutoPlay" on page 
C-1.

4. Click the Install software for NOMAD Jukebox Zen NX option to select 
it.

5. Click the OK button.
6. Click the Next button to register with Creative, so that you will be 

updated on new developments for your Jukebox.
7. Follow the onscreen instructions.
8. When prompted to restart your computer, leave the CD in the CD-ROM 

drive, and then click the Yes, I want to restart my computer now 
option to select it.

9. Click the Finish button to complete the installation.

You must restart your 
computer before trying 
out any of the installed 
applications.

You can also select the 
language that your 
player’s screens 
appear in. See 
"Language Settings" 
on page D-3.
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Connecting 
your Player to 
your Computer

You are now ready to connect your player to your computer. Your NOMAD 
Jukebox Zen NX comes with a USB 2.0 cable for fast data transfers to and 
from your computer. Be sure that you have installed Creative MediaSource 
before connecting your player.

You can listen to your 
player’s preloaded 
music immediately by 
pressing the Play 
button. 

Basic instructions on 
how to use Creative 
MediaSource are 
provided in "Using 
Creative MediaSource" 
on page 4-2. 
Basic instructions on 
how to use File 
Manager are provided 
in "Using File Manager 
2" on page 4-7.

USB port
Getting Started 2-6



Transferring 
Music

Audio selections have been preloaded to your player to get you started 
quickly. If you wish to listen to music immediately, simply press the Play 

button . 

However, if you wish to download additional music tracks to your player, you 
can either download music tracks from Internet music sites (see 
"Downloading from the internet" on page 2-8) or have them "ripped" from 
audio CDs to your computer. 

Music files must, however, be encoded into the supported formats (MP3, 
WMA or WAV file formats), then transferred to your player with Creative 
MediaSource Organizer.

Data files can also be transferred and stored in your player. For example, 
you want to transfer a large movie file from one computer to another. Data 
can be transferred to your player with the Creative File Manager 2 
application.
Getting Started 2-7



Downloading 
from the internet

To get MP3 files from the Internet, use a search engine to locate sites with 
MP3 content. You can also try out these sites (web sites listed here are 
correct at the time of this document’s release):

Follow the instructions on the site and download the music files to your 
computer.

Ripping from a 
CD

The first phase in making an MP3 file is extracting audio data from an audio 
CD. To extract audio data, you will need a CD-ROM drive that can extract 
digital audio data, and a program known as a Ripper. With Creative 
MediaSource Organizer, you can rip tracks from most audio CDs. This 
program uses the CD-ROM drive to read the audio tracks from the audio CD 
and stores it on your hard disk. 

The time needed for a successful audio extraction depends on:
❍ CD-ROM drive speed
❍ defects, like scratches on the audio CD
❍ error-checking features on the CD-ROM drive

It is illegal to encode 
MP3 files for trade or 
sale unless you have 
the express or explicit 
permission of the 
copyright holder(s).

❍ NOMADWorld 
http://www.NOMADworld.com

❍ AMP3.com
http://www.amp3.com

❍ SoundClick.com
http://www.soundclick.com

❍ ArtistOne.com
http://www.artistone.com

❍ Epitonic.com
http://www.epitonic.com

❍ Soundbuzz.com
http://www.soundbuzz.com
Getting Started 2-8



Encoding is the second phase of making an MP3 file. Encoders are used to 
convert the stored audio tracks, usually WAV files, into MP3 files. MP3 
encoding is considered lossy compression, which means that some data is 
lost during compression. However, using the standard sampling rate and 
bitrates will ensure that your MP3 files retain much of their audio quality. The 
standard bitrate of most MP3 files is 128 Kbps, although some are set 
higher, at 160 or 192 Kbps. Higher bitrates will result in larger MP3 file sizes, 
with better audio quality. Use Creative MediaSource Organizer to extract 
audio tracks and encode MP3s. 

See the Creative MediaSource Organizer online Help for more 
information.
Getting Started 2-9
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Playing and Managing Your Music

Playing Music

Music Playback Audio selections and an Audio Tour of your NOMAD Jukebox Zen NX have 
been preloaded to your player to get you started quickly.

You can add audio selections from the NOMAD Jukebox Zen NX’s Music 
Library to the player’s Selected Music List as described in "Adding Music 
Tracks to the Selected Music List" on page 3-11, then play back the entire 
Selected Music List.

To add audio tracks to NOMAD Jukebox Zen NX’s Music Library, see "Using 
Creative MediaSource" on page 4-2.

Playing the 
Selected Music List

Follow these steps to play the Selected Music List.

1. Press the Play button . 

The Play icon  appears onscreen and the Selected Music List is 
played back, from the first track to the last.

2. Press the Menu button . 
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3. Scroll Select Selected Music. The upper-left corner of the screen will 
display the Selected Music List icon.

4. Press the Back button again to display the Menu screen.
5. Scroll Select Now Playing, which shows the track that is being played 

back or the track that has been selected. The upper-left corner of the 
screen will display the Now Playing icon.

Playing all tracks in 
your player

Follow these steps to play all audio tracks in your player.

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select Play any track. All the tracks in your player are 

automatically added to the Selected Music List and are played back 
randomly.

Audio Selections

Selected Music 
List icon

Album Title

Elapsed Time BarNow Playing 
Icon

Track Title
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Play Modes Your player has Play Modes that allow you to change how your Selected 
Music List is played back. 

The following Play Modes are available:
❍ Repeat track
❍ Repeat all
❍ Shuffle
❍ Shuffle repeat
❍ Track once
❍ Normal

Play Modes are disabled by enabling the “Normal” mode as described in 
"Normal mode" on page 3-6. 

Repeating music You can choose to repeat a track or repeat the whole Selected Music List.

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.
5. Depending on which mode you want, follow the corresponding step:

To repeat a track in the Selected Music List

Scroll Select Repeat track. 

The Repeat Track icon  appears onscreen and the track is repeated 
continuously until you stop it. 

If there is only one 
track in the Selected 
Music List when 
"Repeat All" is 
enabled, that track 
will be repeated 
continuously.
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To repeat the whole Selected Music List

Scroll Select Repeat All. 

The Repeat All icon  appears onscreen and the Selected Music List 
is repeated continuously until you stop it.

Shuffling music The Shuffle Play Mode can be used once (“Shuffle”) or continuously (“Shuffle 
Repeat”).

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.
5. Depending on which mode you want, follow the corresponding step:

To Shuffle the Selected Music List once

Scroll Select Shuffle. 

The Shuffle icon  appears onscreen and a track is selected at 
random and played back. The Selected Music List stops playing once all 
the tracks in the Selected Music List are played back once.

If there is only one 
track in the Selected 
Music List when 
"Shuffle Repeat" is 
enabled, that track 
will be repeated 
continuously.
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To Shuffle Repeat the Selected Music List continuously

Scroll Select Shuffle Repeat. 

The Shuffle Repeat icon  appears onscreen and tracks are selected 
at random and played back continuously until you stop playback.

Playing a track 
once

When the Selected Music List is played normally, each track in the Selected 
Music List is played, from the first track to the last. However, when the Track 
Once Play Mode is enabled, playback stops once the current track ends.

1. Press the Menu button .

2. Scroll Select Now Playing.
The Now Playing screen appears.

3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.

5. Scroll Select Track Once. The Track Once icon  appears onscreen. 
The Selected Music List stops playing once the track ends.
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Normal mode Once the Normal mode is enabled, each track in the Selected Music List is 
played, from the first track to the last.

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.
5. Scroll Select Normal. The Selected Music List plays back normally.
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Bookmarking a 
track

Bookmarking a track sets a playback point—you can jump to this point 
whenever you play the bookmarked track. This is useful if, for example, you 
want to bookmark an audio book.

1. Press the Menu button .
2. Scroll Select Now Playing.

The Now Playing screen appears. 

3. Press the Scroller. A list appears.
4. Depending on which mode you want, follow the corresponding step:

To bookmark a track

Scroll Select Set Bookmark at the point where you want to set the 
bookmark. A message box appears, telling you that the bookmark has 
been set at the selected point.

To play the track from the bookmarked point

Scroll Select Go to Bookmark. The track plays from the bookmarked 
point.

A track can only be 
bookmarked once; 
setting a new 
bookmark will 
automatically 
remove any previous 
bookmark in the 
track.
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To remove a bookmark

Scroll Select Clear Bookmark. A message box appears, telling you that 
the bookmark has been cleared.
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Organizing 
your Music

To effectively manage the music in your player, you should be familiar with 
what the Music Library, Selected Music List and Playlists are. These will be 
described extensively in the following sections:
❍ "Using the Music Library" on page 3-9
❍ "Using the Selected Music List" on page 3-16

Using the 
Music 
Library

When audio tracks are transferred to your player, they are organized into the 
following Music Library categories:
❍ Playlists
❍ Albums
❍ Artists
❍ Genres
❍ All Tracks

All transferred tracks can be found in the "All Tracks" category, but 
depending on your Creative MediaSource settings, tracks can also be found 
in other categories. For example, take a fictitious track called "Toffee Apple 
Smile", performed by "The Nano Singers", from the soundtrack to the movie 
"The Big Sneeze". Besides "All Tracks", the "Toffee Apple Smile" song would 
also be found in the "Soundtrack" genre, the "Songs from The Big Sneeze" 
album, and the "The Nano Singers" artist category.

Tracks not belonging to any album, artist, or genre can only be found in the 
“Unknown” category. You can use the Music Library to:
❍ Add audio selections to the Selected Music List
❍ Find tracks, playlists, albums, artists or genres 
❍ View track information
❍ Delete tracks, playlists, albums, artists or genres
❍ Preview a track

To transfer audio 
tracks to NOMAD 
Jukebox Zen NX’s 
Music Library, see 
"Using Creative 
MediaSource" on page 
4-2.

Modifying or renaming 
albums, artists, or 
genres must be done 
in Creative 
MediaSource. Only 
Selected Music Lists 
can be renamed in the 
player.
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Finding a Music 
Track in the 
Music Library

In the following example, you will be shown how to find a track by navigating 
through your Music Library.

1. Press the Menu button .

2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if you want to find a track 

in a particular album, Scroll Select Albums.
Note: If Scroll Selecting All Tracks, go to Step 5.

4. Scroll Select the sub-category. For example, under Albums, Scroll Select 
an album title. A list appears.

5. Scroll Select Open. The tracks within the sub-category appear.
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Adding Music 
Tracks to the 
Selected Music 
List

Audio selections from the Music Library can either be added sequentially 
after selections already in the Selected Music List ("Add to Play") or placed 
at the front of the Selected Music List for immediate playback ("Play Now").

1. Press the Menu button .

2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if you want to add a track 

in a particular album, Scroll Select Albums.

4. Scroll Select the sub-category. For example, under Albums, Scroll Select 
an album. A list appears.
Note: If adding an entire album, artist, genre or playlist, skip to step 6.

When a playlist is 
added to the 
Selected Music List, 
only the selections 
within that playlist 
are added. The 
playlist itself is not 
added.
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5. Scroll Select Open. The tracks within the sub-category appear.

6. Scroll Select Add to Play to add the audio selection to the back of the 
Selected Music List. 

7. Scroll Select Play Now or press the Play button   to add the 
selection to the front of the Selected Music List and immediately play it 
back.
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Viewing Track 
Information in 
the Music Library

Detailed information about tracks in the Music Library is readily available. 
This includes the track’s title, artist, album and genre that the track belongs 
to, as well as the track’s length.

To view information about tracks in the Music Library

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if you want to find a track 

in a particular album, Scroll Select Albums.
4. Scroll Select the track you want information on. A list appears.
5. Scroll Select Track Details. A message box appears, listing track 

information.
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Deleting Music 
Tracks from the 
Music Library

This action permanently deletes tracks, albums, artists, genres or Selected 
Music Lists from  your NOMAD Jukebox Zen NX.

To delete a track

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if you want to find a track 

in a particular album, Scroll Select Albums.
4. Scroll Select the track you want to delete. A list appears.
5. Scroll Select Delete Track. A confirmation box appears, asking you if 

you want to delete the selected track.

6. Scroll Select the check mark . 
The track is permanently deleted from your player.
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To delete an entire album, artist, genre or Selected Music List

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if you want to delete a 

particular album, Scroll Select Albums.

4. Scroll Select Open.
5. Scroll Select the sub-category. For example, under Albums, Scroll Select 

the album title you want to delete. A list appears. Depending on what you 
are deleting, Scroll Select Delete Album, Delete Artist, Delete Genre 
or Delete Playlist. A confirmation box appears, asking you if you want to 
delete the selected album, artist, genre or playlist.

6. Scroll Select the check mark . The album, artist, genre or playlist is 
permanently deleted from your player.

You can also view 
track information 
from the Selected 
Music List. See 
"Viewing track 
information in the 
Selected Music List" 
on page 3-18
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Using the 
Selected 
Music List

You can do more than play audio selections in the Selected Music List. You 
can:
❍ View audio in the Selected Music List
❍ View information about tracks in the Selected Music List
❍ Remove audio
❍ Rearrange the Selected Music List
❍ Save the Selected Music List as a playlist

Viewing music 
tracks in the 
Selected Music 
List

When entire albums, artists or genres are added to the Selected Music List, 
the tracks within them are hidden (or "collapsed"). To see these tracks, you 
must "Expand" the album, artist or genre. Similarly, to hide these tracks, you 
should "Collapse" the album, artist or genre. This can be useful in reducing 
screen clutter.

To expand an album, artist or genre

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.

3. Scroll Select the album, artist or genre to expand. A list appears.
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4. Scroll Select Expand. The tracks in the selection appear beneath the 
album, artist or genre.

To collapse an album, artist or genre

1. Press the Menu button .

2. Scroll Select Selected Music.
The Selected Music List screen appears.

3. Scroll Select the expanded album, artist or genre. A list appears.
4. Scroll Select Collapse. Tracks within the formerly expanded album, 

artist or genre are hidden.
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Viewing track 
information in the 
Selected Music 
List

Information about tracks in the Selected Music List can be easily accessed 
and viewed. The information provided is identical to that described in "To 
view information about tracks in the Music Library" on page 3-13.

1. Press the Menu button .
2. Scroll Select either Selected Music or Now Playing.

Track information can be viewed in either the Selected Music List or 
Now Playing screen.

3. On the Selected Music List screen, Scroll Select the track that you want 
to view information about.
On the Now Playing screen, press the Scroller.
In either case, a list appears.

4. Scroll Select Track Details. A message box appears, listing track 
information.
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Removing music 
tracks from the 
Selected Music 
List

When tracks, albums, artists or genres are removed from your player’s 
Selected Music List, they are only removed from the Selected Music List—
audio still remains in the Music Library. To delete audio completely, tracks, 
albums, artists or genres must be deleted from the Music Library as shown in 
"Deleting Music Tracks from the Music Library" on page 3-14.

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.

3. Scroll Select the track, album, artist or genre to remove from the 
Selected Music List. A list appears.

4. Depending on whether you want to remove a track or remove all audio 
from the Selected Music List, follow the corresponding step:

To remove a track, album, artist or genre from the Selected Music 
List

Scroll Select Remove. The track, album, artist or genre is removed from 
the Selected Music List.
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To remove all audio from the Selected Music List

1. Scroll Select Remove All. A confirmation box appears, asking you if you 
want to remove all tracks in the Selected Music List.

2. Scroll Select the check mark .
All audio selections are removed from the Selected Music List.
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Rearranging the 
Selected Music 
List

If you want to listen to tracks in a particular order, you can rearrange the 
tracks in the Selected Music List by artist, genre or individual track.

1. Press the Menu button .

2. Scroll Select Selected Music.
The Selected Music List screen appears.

3. Scroll Select the album, artist, genre or individual track to move. A list 
appears.

4. Scroll Select Change Order. An icon appears next to the selected 
album, artist, genre or individual track.
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5. Using the Scroller, move the album, artist, genre or individual track to the 
preferred position in the Selected Music List.

6. Press the Scroller to set the position you have selected.
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Saving the 
Selected Music 
List as a playlist

If you like the contents and arrangement of your current Selected Music List, 
you can choose to save it as a playlist for retrieval and playback later.

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.

3. Press the Scroller. A list appears.
4. Scroll Select Save as Playlist. A list appears.

When you remove 
audio tracks from the 
Selected Music List, 
you are not 
permanently deleting 
the selections from 
your player.
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5. Scroll Select the letters on the list to form a name for your playlist. This 
name appears in the box at the bottom of the screen.

Note: When entering letters into the box, you can switch from upper to 
lower case (or vice-versa) by simply Scroll Selecting the letter and holding 
the Scroller until the letter changes to the case you want. You can also use 
different character sets, such as accented characters or numerals, by Scroll 
Selecting the Charset option on the list.

6. Scroll Select the OK option to save the playlist with the name you have 
entered.
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Enhancing 
Your Music

Using EAX Your player allows you to enhance your listening experience with EAX 
technologies also available with Creative's Sound Blaster Live! and Audigy 2 
audio cards. EAX technologies (or "Settings") available in your player 
include:
❍ Environment, a collection of presets that allows you to experience audio in the 

virtual environment of your choice. Choose from the following Preset settings: 
Auditorium, Bath Room, Cathedral, Concert Hall, Garage, Indoor Arena, Jazz 
Club, Living Room, Opera House, Small Room and Theater.

❍ Time Scaling, which allows you to speed up or slow down audio without 
changing pitch or distorting sound quality.  Choose from the following Rate 
settings: 0.50x, 0.75x, 1.00x, 1.25x and 1.50x.

❍ Advanced EQ, a collection of equalizer settings which can enhance audio of a 
particular genre. Consists of Custom EQ, Acoustic, Classical, Disco, Jazz, New 
Age, Pop, Rock, and Vocal. Scroll Select Custom EQ to set it from +12 dB 
(maximum) to -12 dB (minimum). See "Customizing EQ Settings in EAX" on 
page 3-27.

❍ Spatialization, which enhances your audio soundstage, useful if, for example, 
you are listening to audio with headphones. Choose from the following Mode 
settings: Full, Narrow and Wide.

❍ Smart Volume Management (SVM), which intelligently controls the dynamic 
range of audio, providing a superior audio experience in difficult listening 
environments such as in a plane or car.

General information 
about EAX is 
available at 
www.NOMADworld.
com.
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To use EAX with your currently playing audio:

1. Turn on EAX.
2. Select an EAX setting.
3. Select a preset, rate or mode to use with the selected EAX setting.

This simple process is described in the following instructions.

1. Press the Menu button .

2. Scroll Select EAX Audio.
3. Follow the corresponding step to either turn on EAX, select an EAX 

setting, or select a preset, rate or mode for use with your EAX setting:

To turn on EAX:

Scroll Select EAX:Off. The EAX icon  appears onscreen and is 
applied immediately to the audio being played.

To select an EAX setting

Scroll Select Setting:X (replace X: with the EAX setting currently 
selected). A list appears.

Scroll Select the EAX setting you want.

To select a preset, rate or mode for use with your EAX setting

Scroll Select Preset:X, Rate:X or Mode:X (replace X with the preset, 
rate or mode currently selected). A list appears.
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Scroll Select the preset, rate or mode you want to use with your EAX 
setting.

Customizing EQ 
Settings in EAX

Under the EAX Advanced EQ settings, a Custom EQ option lets you define 
your own EQ settings.

1. Press the Menu button .
2. Scroll Select EAX Audio.
3. Scroll Select Setting: Advanced EQ.
4. Scroll Select Preset: Custom EQ. A list appears.
5. In the Preset screen, Scroll Select Custom EQ again. Four vertical 

control levers will appear in the display. Each lever represents 
successively higher frequencies that can be controlled. 100 Hz controls 
bass frequencies, 800 Hz and 3 KHz adjust the mid-range and low-treble 
frequencies. 12 KHz controls the highest treble frequencies.
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6. Scroll Select each vertical control level. Use the Scroller to move the 
control knob up or down to vary the amount of boost or reduction in the 
selected frequency range.

7. Scroll Select the check mark to return to the EAX Audio Settings.
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Software Applications

About Creative 
MediaSource 
and File 
Manager 2

Creative MediaSource, Creative File Manager 2, and other useful software, 
are included on your installation CD (see "Installing Software" on page 2-5).

Creative MediaSorce is the best way to organize and transfer audio to and 
from your player. This chapter includes basic instructions on using 
MediaSource to rip audio CDs, transfer tracks by manual selection or with 
AudioSync, edit track information as well as to create and edit playlists.

Creative File Manager 2 helps you manage your NOMAD Jukebox's data 
files within Windows Explorer.  This chapter includes basic instructions on 
using File Manager 2 to manage the file and folders in your player.
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Using Creative 
MediaSource

Only basic instructions on how to use MediaSource with your player are 
provided in this chapter— extensive instructions are found in the 
MediaSource Help file.

Ripping Audio CD 
Tracks

You can rip an audio CD’s tracks to your player, hard disk or PC Music 
Library. You can choose to rip an entire CD, or selected tracks from the audio 
CD.

To rip a CD

1. Insert an audio CD into your CD-ROM drive.
2. If you are not already in Creative MediaSource Organizer, click the 

Player/Organizer View button. 
3. In the Sources window, select [e:] Audio CD (replace e: with your 

CD-ROM drive).
4. In the Task bar, click the Rip Now button.

To rip tracks from an audio CD

1. Insert an audio CD into your CD-ROM drive.
2. If you are not already in Creative MediaSource Organizer, click the 

Player/Organizer View button. 
3. In the Sources window, select [e:] Audio CD (replace e: with your 

CD-ROM drive).
4. In the Content window, select the tracks to rip.

Ctrl-click or Shift-click to select multiple tracks.
5. Drag the selected tracks to PC Music Library in the Source window.

The Transfer Queue dialog box appears, showing the current ripping 
status.

Rather than manually 
entering track 
information, retrieve 
such audio CD 
information from CDDB 
before ripping tracks.

Change the default 
ripping format and 
bitrate for higher or 
lower quality audio. 
See MediaSource’s 
Help file for details
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Transferring tracks With Creative MediaSource, you can transfer files and audio tracks to and 
from your player.

To transfer files from one source to another

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button. 

2. Click the Show/Hide Right Panel button.
3. In the Sources window, select the source device.

If you are transferring files from PC Music Library to a portable hard disk, 
select PC Music Library as your source.

4. In the Content window, select the tracks to transfer.
CTRL-click to select multiple tracks.

5. In the Right Panel window, click the Source bar and select the 
destination.

6. Click the Destination Transfer button to transfer the selected tracks.
The Now Transferring dialog box appears, showing the current transfer 
status.
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Editing audio track 
information 

You may need to edit track information when the information is incomplete or 
wrong. 

To edit information about a track

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Content window, locate the track you want to edit, and right-click 
it.

3. Select the Edit Track Properties option.
4. type in the new information.
5. Click the OK button.

The track's information is changed.

To edit information about multiple tracks 

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Content window, locate the tracks you want to edit, and right-click 
them.

3. Select to edit the Album, Artist or Genre.
4. Type in the new Album, Artist or Genre.
5. Click the OK button.
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Creating a playlist Creative MediaSource allows you to create playlists from the Selected Music 
List or from the PC Music Library. You can create playlists by:
❍ clicking the New Playlist icon
❍ saving the Selected Music List
❍ saving tracks from the Content window

To create a playlist 

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Sources window, select PC Music Library.
3. On the Task bar, click the New Playlist icon.
4. Type in the name of the playlist.
5. Click the OK button.

To create a playlist by saving the Selected Music List 

1. When you have the tracks in the order that you like in the Selected 
Music List, click the Save As button.

2. Type in the name of the playlist.
3. Click the OK button.

The playlist appears in the Sources window, in PC Music Library

To create a playlist by saving tracks from the Content window

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Content window, locate the track that you want.
3. Right-click the track, and select the Add to playlist option.

Owing to copyright 
limitations, preloaded 
tracks in your player 
cannot be transferred 
to your computer.
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4. In the Add Tracks to Playlist dialog box, enter a playlist name to create 
a new playlist with the selected track, or select an existing playlist to add 
the track to.

5. Click the OK button.
6. Continue selecting tracks until your playlist is complete.

Adding audio tracks 
to a playlist

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Sources window, click the plus sign next to Playlists and select 
the playlist.

3. Select PC Music Library.
4. In the Content window, select the track you want to add.
5. Click and drag the track to the selected playlist.

Changing the 
playback order in a 
playlist

1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Sources window, click the plus sign next to Playlists and select 
the playlist to be changed.

3. Click and drag tracks to their new positions in the playlist.

Deleting a playlist 1. If you are not already in Creative MediaSource Organizer, click the 
Player/Organizer View button.

2. In the Sources window, click the plus sign next to Playlists and right-
click the playlist to be deleted.

3. Select the Delete option.
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Using File 
Manager 2

Instructions on how to use File Manager 2 are in the File Manager 2 Help 
file—only basic instructions are provided here.

Creating a folder 1. In Windows Explorer, locate and click the Nomad Explorer icon .
2. On the View menu, point to Active Device and click NOMAD Jukebox.
3. If you have more than one NOMAD Jukebox connected to your 

computer, click the NOMAD Jukebox that you want to set as active. Only 
one NOMAD Jukebox can be active at any one time.

4. On the File menu, point to New and click Folder. Or, click the New 
Folder icon on the toolbar of Windows Explorer.

5. A new folder appears with a temporary name.
6. Type a name for the new folder and then press <ENTER>.
7. In Windows Explorer, locate and click the Nomad Explorer icon .

Opening a folder 1. On the View menu, point to Active Device and click NOMAD Jukebox.
2. If you have more than one NOMAD Jukebox connected to your 

computer, click the NOMAD Jukebox that you want to set as active. Only 
one NOMAD Jukebox can be active at any one time.

3. Double-click the folder you want to open.
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Deleting a file or 
folder

1. In Windows Explorer, locate and click the NOMAD Explorer icon .
2. On the View menu, point to Active Device and click NOMAD Jukebox.
3. If you have more than one NOMAD Jukebox connected to your 

computer, click the NOMAD Jukebox that you want to set as active. Only 
one NOMAD Jukebox can be active at any one time.

4. Click the file or folder you want to delete.
5. On the File menu, click Delete. Or, click the Delete icon  on the toolbar of 

Windows Explorer.

Changing the name 
of a file or folder

1. In Windows Explorer, locate and click the NOMAD Explorer icon .
2. On the View menu, point to Active Device and click NOMAD Jukebox.
3. If you have more than one NOMAD Jukebox connected to your 

computer, click the NOMAD Jukebox that you want to set as active. Only 
one NOMAD Jukebox can be active at any one time.

4. Click the file or folder you want to rename. 
5. On the File menu, click Rename. 
6. Type the new name, and then press <ENTER>. 
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Technical Specifications

Size ❑ 2.99" (W) x 4.43" (H) x 0.95" (D) or 75.9 mm x 112.5 mm x 
24.1 mm

Weight ❑ 8.0 oz or 226 gms (with the battery)

Memory ❑ 8 MB SDRAM buffer

Capacity ❑ 20/30 GB hard drive

Battery type ❑ Lithium-ion battery (removable)

Battery Life 
(playback time)*

❑ Up to 14 hours of continuous playback from a fully charged 
Lithium-ion battery. The following may reduce the playback time:

• playback of tracks encoded at bitrates higher than 128Kbps
• use of EAX effects or environments
• skipping, fast forward or reverse during playback
• using passive speakers or high-power headphones
• long backlight timeout setting (more than 10 secs)
• playback of WMA files

Interface ❑ USB 2.0/USB 1.1

* Battery life estimated for continuous playback of tracks encoded at 128 kbps.
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Playback Formats**
❑ MP3 (at 8, 16, 22.05, 24, 32, 44.1 and 48 kHz)
❑ WMA (at 16, 22.05, 24, 32, 44.1 and 48 kHz)
❑ Wave (at 32, 44.1, 48 kHz)

Signal to Noise 
Ratio

❑ Up to 98 dB (Headphones)

Channel 
Separation

❑ Up to 75 dB (Headphones)

THD ❑ <0.1%

Frequency 
Response

❑ 20 Hz~20000 Hz

Harmonic 
Distortion

❑ <0.02%

Operating System/
Firmware

❑ Upgradeable via Internet

Headphone Out ❑ 1/8" (3.5 mm) stereo minijack, 100 mW (Wide, Narrow, Front 
only)

LCD Display ❑ Large 132 x 64 pixel LED backlit display, in Green

** Firmware upgrades are available from www.NOMADworld.com
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Data Connector ❑ USB 2.0/USB 1.1

EAX ❑ Environment effects
❑ Parametric equalization
❑ Headphone spatialization
❑ Smart Volume Management
❑ Advanced EQ
❑ Time Scaling

Playback Speed ❑ Up to 1.5 times faster or 0.5 times slower for audio book content, 
WMA, WAV and  MP3 audio playback
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Onscreen Diagram and Icon Guide

Information 
Diagrams

The following icons 
appear onscreen when 
the associated 
playback action is 
used.

Diagram Action/Meaning

❍ your computer is actively managing your player. 
To use your player, disconnect it from your 
computer.
Warning: Do not disconnect your player while 
your computer is still actively managing it.

❍ your computer is NOTactively managing your 
player. To use your player, disconnect it from 
your computer.

❍ you are upgrading your player’s firmware.

❍ the firmware upgrade is complete. Reset your 
player to enable the new firmware to take effect. 
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Playback Icons
Icon Action/Meaning

❍ Play

❍ Pause

❍ Forward

❍ Reverse

❍ Skip forward

❍ Skip back
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Selected Music 
List Icons Icon Action/Meaning

❍ Album

❍ Artist

❍ Genre

❍ Track

❍ Track within audio 
category

❍ Audio selected for 
playback or that is 
currently playing 
back

The following icons are 
commonly found in the 
Selected List screen.
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Play Mode 
Icons Icon Action/Meaning

❍ Repeat Track

❍ Repeat All

❍ Shuffle

❍ Shuffle Repeat

❍ Play Track Once

The following icons 
appear onscreen when 
the respective audio 
enhancements are 
active.
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Navigational 
Icons

The following icons 
appear onscreen when 
you are in the 
associated firmware 
section.

Icon Action/Meaning

❍ Menu

❍ Selected Music List

❍ Now Playingk

❍ Music Library

❍ Playlists category

❍ All Tracks category

❍ Albums category

❍ Artists category
Onscreen Diagram and Icon Guide B-5



❍ Genre category

❍ EAX

❍ Find

❍ Settings

❍ About

Icon Action/Meaning

The following icons 
appear on-screen when 
you are in the 
associated firmware 
section.
Onscreen Diagram and Icon Guide B-6



Frequently Asked Questions and 
Error Diagrams
 



FAQs and Troubleshooting

This section covers common problems you might encounter or questions you 
might have while using your NOMAD Jukebox Zen NX. If you have a 
technical problem with this product, you may wish to consult our self-help 
tool “Knowledgebase” for online troubleshooting and solutions. Go to 
www.creative.com and select your region.

The Frequently Asked Questions (FAQs) have been divided into a few 
categories for your easy reference.

AutoPlay What do I do when the installation does not start automatically after the 
Installation CD is inserted?

The AutoPlay feature in your Windows system may not be enabled.

To start the installation program through the My Computer 
shortcut menu

1. On your Windows desktop, double-click the My Computer icon.
2. Right-click the CD-ROM drive icon, and then click AutoPlay.
3. Follow the onscreen instructions.

To enable AutoPlay through Auto Insert Notification

4. Click Start -> Settings -> Control Panel.
5. Double-click the System icon. The System Properties dialog box 

appears.
6. Click the Device Manager tab and select your CD-ROM drive.
7. Click the Properties button.
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8. Click the Settings tab, and then select Auto Insert Notification.
9. Click the OK button.

Features If I make a bookmark in a track, will the track play back from the 
bookmarked point?

No, you have to manually select "GO TO BOOKMARK". See "To play the 
track from the bookmarked point" on page 3-20 for more information.

If the Selected Music List already has a few albums in it, can I repeat 
playback of just one album?

Unfortunately, no. You can only choose to repeat one track, or all tracks. 

Why does my player show me track titles starting with "B" when I’m 
looking for a track title starting with "A"?

When you look for a track using the FIND feature, your player looks for the 
closest match. If you do not have any tracks starting with "A", the closest 
match can be "B".

General Where can I get official information on all Jukebox products?

Visit NOMADworld for updates and downloads relating to all Jukebox 
products, Creative’s MP3 players and accessories. Visit 
www.NOMADworld.com.
My player seems to have frozen. Is there anything I can do?

You can reset your player. Insert the end of a straightened paper clip into the 
Reset button.
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How can I get accessories for my Jukebox?

Visit www.NOMADworld.com for the latest news on accessories.
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Windows XP tells me that the software for the player is not certified. 
What do I do?

At the time of this product's release, Microsoft strongly encouraged 
companies to submit their hardware solutions for certification. If a hardware 
device driver is not submitted, or does not qualify, for Microsoft certification, a 
warning message similar to the one below appears.

You may see this message when installing this driver or update. If you do, 
you may choose to click the Continue Anyway button. Creative has tested 
this driver or update on Windows XP, and it does not impair or destabilize 
your computer.
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Maintenance Do I need to defragment the player’s hard disk?

No, you will not need to defragment, format or clean up the hard disk at all. 
The player’s unique file system ensures that you will not have to worry about 
hard disk maintenance.

Usage Can I jog with my NOMAD Jukebox Zen NX?

You should not subject your player to continuous shocks, such as those that 
are likely to occur while you jog or run. You can take a nice long walk with 
your player, though.

Can I use the NOMAD Jukebox Zen NX for portable data storage?

Yes, you can. However, the Jukebox is designed for storing and playing 
audio, not as an extra hard drive. You can use the USB cable for speedy 
transfers to and from your player. Your player will not be recognized as a 
drive. Use the File Manager 2 application to help you manage data files.

I have to recharge the battery quite often. Is there anything I can do to 
make it last longer?

Generally, any operation requiring the player to access the hard disk uses 
battery power. Consequently, filling your player to capacity is not 
recommended. However, some operations consume more battery power:
❍ a long backlight timeout setting. A shorter timeout conserves battery power.
❍ a high contrast setting. Position the player so that you can read the display 

without using a high contrast setting.
❍ too much use of fast forward/reverse. 
❍ turning the player on/off too many times.
❍ use of EAX effects or environments.
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❍ use of passive speakers or high-powered headphones.

Proper charging and handling of the battery can also help in prolonging 
battery life and charge.

Should I leave my player plugged into the AC adapter?

No, you should not. After charging the battery or using the player, disconnect 
it from the AC power adapter. Leaving it plugged in leads to heat buildup, 
which is not good for the player or the battery.

If I damage or lose my AC adapter, can I buy a similar, off-the-shelf 
adapter?

No. The adapter may not be compatible with your player, and may even 
damage it. You should get a replacement adapter from Creative at 
www.NOMADworld.com, or your local Creative office/distributor.
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Error Diagrams If an error occurs, you may see any one of the following diagrams, indicating 
the general nature of the problem.

Diagram Likely Causes Suggested Action

❍ unexpected power 
loss while saving 
settings

❍ download a newer 
firmware version

❍ reload firmware
❍ call Technical Support

❍ physical defects
❍ numerous high-

impact shocks
❍ call Technical Support

❍ battery is too 
depleted, player 
cannot start up

❍ recharge the battery
❍ use DC power

❍ firmware corruption
❍ see actions for firmware 

problems

❍ unexpected power 
loss during audio file 
transfer

❍ allow firmware to 
complete the rebuilding 
of the library
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User Preferences

Setting User 
Preferences

Your player offers many configuration options. You can
❍ personalize your Jukebox
❍ specify profiles
❍ set the contrast level for your player’s screen
❍ select the default language
❍ reset your player
❍ lock and unlock your player’s buttons
❍ access the information screen

Personalize your 
Jukebox 

In this screen you can:
❍ set the owner’s name
❍ return to the previous screen

1. From the Settings screen, Scroll Select Personalization.
2. Scroll Select one of the options.
3. From the menu, Scroll Select a setting or construct a name.
4. To save the setting, Scroll Select OK.

To construct a name, 
Scroll Select the letters 
and numbers to form 
the name. Each letter 
and number selected is 
entered into the entry 
area.
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Profiles  

In this screen, you can:
❍ select a profile
❍ clear the Selected Music List whenever you Scroll Select the Play Now option.
❍ change the skin of the Now Playing screen
❍ specify the default start screen
❍ enable the screensaver
❍ specify how long the player remains inactive before it automatically shuts down.
❍ play your favorite music tracks for a specified time period, using the Sleep 

Timer option.
❍ enable Car mode. If your player is connected to your car using a Car Kit (see 

"Optional Player Accessories" on page xxiv), it will turn itself on and off when 
you turn the car engine on or off.

❍ adjust the screen backlight duration. A lower number setting conserves battery 
power for longer playback time.

❍ return to the previous screen

1. From the Settings screen, Scroll Select Edit Profile.
2. Scroll Select the settings that you want, and then Scroll Select the left 

arrow to exit the Profile screen.
3. To enable the edited profile from the Settings screen, Scroll Select 

Profile. A list appears.
4. Scroll Select the profile that you want. There are different profiles to suit 

your needs (for example, Standard, Advanced, At Home or Car Player).
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Setting Sleep Timer Sleep Timer lets you play music tracks for a specified time period.
1. From the Settings screen, Scroll Select Edit Profile.
2. Scroll Select Sleep Timer.
3. Select a playback time.
4. Scroll Select the left arrow to exit the Profile screen.
5. To enable the edited profile from the Settings screen, Scroll Select 

Profile. A list appears.
6. Scroll Select the profile that you want.

Contrast This option sets the contrast level for your player’s screen. The lower the 
number, the lower the contrast.
1. From the Settings screen, Scroll Select Contrast. A list appears.
2. Scroll Select the contrast setting that you want.

Language 
Settings

You can change the default language used on your player’s screens and 
input boxes.

Menu Language This option controls the language in which your player’s menus are 
displayed.
1. From the Settings screen, Scroll Select Menu under Language.
2. From the menu, Scroll Select a language.

You can also lock your 
player by pressing the 
Power button. Scroll 
select the check mark. 
The player is locked. 
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Input Language This option controls the language in which you input letters or characters in 
input boxes, for example, when you search for a track or rename a playlist.
1. From the Settings screen, Scroll Select Input under Language.
2. From the menu, Scroll Select a language.

Time and Date This option allows you to set the date and time, and set the Wake to Music 
feature. The Wake to Music feature lets you play the last heard music track 
at a specified time.

Setting time and 
date

1. From the Jukebox Settings screen, Scroll Select Time & Date.
2. Scroll Select the date and time that you want to adjust.
3. Turn the Scroller up or down to increase or decrease the date or time, 

and then press the Scroller to save the setting.
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Setting Wake-To-
Music

1. From the Jukebox Settings screen, Scroll Select Time & Date.

2. Scroll Select the time settings next to the Wake to Music icon .
3. Turn the Scroller up or down to increase or decrease the time, and then 

press the Scroller to save the setting.
4. Scroll Select the Wake to Music icon.

  means Wake to Music is enabled, and  means that Wake-To-
Music is disabled.

5. Turn off your player.
Your player will automatically turn on and start playing tracks at the 
specified time.

Accessing the 
Information 
Screen

The Jukebox About screen shows you:
❍ the player’s firmware version — so that you know if you can upgrade the 

firmware
❍ the total amount of space in your player for storing music or data
❍ the available space in your player for storing music or data
❍ the number of tracks stored in your player
❍ the number of albums stored in your player
❍ the number of playlists stored in your player

To see this screen, from the Settings screen, Scroll Select About.

Be sure that your 
player is connected to 
a DC power source 
when using the Wake 
to Music feature.

If there are no music 
tracks in the Selected 
Music List and the 
Wake to Music feature 
is enabled, your player 
will play a random 
track.
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Resetting your 
Player’s Settings

If you wish to reset your player’s settings to the default settings, do the 
following
1. Press the Menu button.
2. Scroll Select Settings.
3. Scroll Select Reset Settings. A confirmation window appears.

4. Scroll Select the check mark .

Resetting your 
Player

If your player stops responding, reset the 
player. This should not cause you to lose any 
data or audio tracks, unless you were in the 
middle of transferring an audio track. You can 
check for the audio track in your music library 
later. See "Using the Music Library" on page 3-
9.

To reset the player: Insert the end of a thin 
object (like a straightened paperclip) into the 
Reset button.
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Locking and 
unlocking your 
Player

Locking your NOMAD Jukebox Zen NX will disable all buttons on the player 
except for the Scroller. This feature is useful when you do not want any 
buttons (for example, Stop) pressed accidentally.

If you press a button while the player is locked, a popup window appears for 
you to unlock the player. This popup disappears if you don’t use the Scroller 
to make a selection within a few seconds.

To lock your player 1. Press the Menu button . 
2. Scroll Select Button Lock.
3. The player is locked.

To unlock your 
player

1. Press any button. A popup window appears.

2. Scroll Select the check mark . The player is unlocked.

Alternatively, you can 
press the Power 
button. A popup 
window appears. Scroll 
Select the check mark.
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